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MESSAGE,C,254

Welcome back to a New Year!

A chicken is an egg's way of producing more eggs.

The infamous Joshi virus is due to strike tomorrow. Scan all drives today. (This message does not indicate the presence of a
The significant problems we face cannot be solved at the same level of thinking we were at when we created them. [Einstein]
Three can keep a secret if two are dead.

The corn is never declared innocent in the court of chickens.

Money is the root of all wealth.

The moon may be smaller than Earth, but it's further away.

Before you attempt to set things right, make sure you see things right.

A mind, one stretched by a new idea, never regains its original dimension.

Truth without a veil is always uninteresting to the human mind.

Always remove the last screw first.

Experience varies directly with the amount of equipment ruined.

Quality is not act, it is a habit. [Aristotle]

To study a subject best, understand it thoroughly before you start.

Don't just believe in miracles: rely on them.

People only see what they are prepared to see. [Emerson]

We make a living by what we get, we make a life by what we give. [Churchill]

Time is just nature's way of keeping everything from happening at once.

All problems look simpler once solved.

It is impossible to make anything foolproof: fools are too ingenious.

A conclusion is simply the place where you got tired of thinking.

Wisdom is knowing when to avoid perfection.

Don't let what you cannot do interfere with what you can do.

If you visualize the wrong thing, you'll produce the wrong thing.

If the groundhog sees its shadow, another six weeks of winter are in store.

Today is Epiphany, that twelfth day of Christmas!

Long range planning does not deal with future decisions, but with the future of present decisions.
Talk is cheap, but supply exceeds demand.

It's New Zealand Day.

If you always plow a straight furrow, you're in a rut.

TimeWise Tip: To protect from eye strain, ensure your monitor is just beyond arm's length.
The more curves in a river, the older it is.

Day becomes night when you can't tell a black thread from a white one.

If you wonder how you will remember an explanation, the design has failed.

Now is yesterday's tomorrow.

If you want something done, give it to a busy person.

Nobody has ever bet enough on the winning horse.

A locked heart can be opened with a duplicate key.

The future belongs to those who prepare for it.

When you look to the heights, hold onto your hat.

Peace is perfected activity.

There is nothing like the prospect of a lot of money to fog otherwise intelligent minds. [Shaw]
Over a bent tree all the goats jump.

When we pick up one end of the stick, we pick up the other.

Misbelief alone misleads. Singlemindedness always leads to the goal.

A good beginning is the job half done.

To treat every human being as a shrine is to fulfill all religion.
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Charge nothing and you get a lot of customers.

Failure comes when will surrenders to reason.

Success comes when the reason of experience surrenders to will.

Even if you're on the right track, you'll get run over if you just sit there.

Old habits can't be thrown out the upstairs window. They must be coaxed down the stairs one step at a time. [Twain]
It's leap day!

Love is the product all the world demands. Make everyone a customer.

The person who rows the boat usually doesn't have time to rock it.

With wisdom alone you don't go to market.

When you climb a ladder, count the rungs.

The Michelangelo virus is due to strike tomorrow. Scan all drives today. (This message does not indicate the presence of a vi
Well-arranged time is the surest mark of a well-arranged mind.

What would be the use of immortality to the person who cannot use well a half hour...
You can't build a reputation on what you are going to do. [Ford]

If you stay at home, you don't wear out your shoes.

You can't shake hands with a clenched fist.

Truth is greater than ten goats.

Failure is the opportunity to begin again more intelligently.

Wisdom is greater and more difficult to attain than intellect.

The closer one get to the top, the more one finds there is no top.

Beware the Ides of March.

Today is yesterday's pupil.

When in Ireland, do as the Irish.

Falsehood is a waste of time and energy.

If you fail yourself, you fail all. Conquer yourself and win all.

Better to measure ten times and cut once, than to do the reverse.

They can crush all the flowers, but they can't stop Spring from coming.

Those who throw dust at the sun: the dust falls in their eyes.

A person creates their own disharmony.

You cannot be both horse and rider at the same time.

Today is the Annunciation of the Lord for Catholics.

Not being able is worse than not having.

Even a blind chicken sometimes finds a kernel.

All goats are able to jump onto a low table.

A little advice can heal a backache.

You can fall down by yourself, but it takes a friend's help to get up.

Today is Family Day in South Africa.

Many viruses are designed to strike on April 1. Scan computers today. (This message does not indicate the presence of a virt
Don't forget to play April Fool's jokes today.

The person who puts their nose to the grindstone risks a scraped nose.

Genius is ten percent inspiration and fifty percent capital gains tax.

All is not butter that comes from a cow.

The surface of the sea makes roaring waves...the depth is silent.

Look for cats and you find mice.

If you wish to remove all the annual noticeboard messages, simply select Noticeboard from the Tools menu and click the Dele
Laugh and the world thinks you're an idiot.

No amount of careful planning will ever replace dumb luck.

We all want the opportunity to prove that money doesn't buy happiness.

Good luck is an eel in the pond of fools.
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Remember, the paper is always strongest at the perforations.

A closed mouth gathers no feet.

After all is said and done, often more is said than done.

Like an ocean, we only see that part of truth within our vision.

Sleep is comfortable, but awakening is interesting.

All requests for sick leave must be approved two weeks in advance.

The key to happiness is having dreams...success is making them come true.
The opposite of a profound truth may well be another profound truth.
Just because everything is different doesn't mean anything has changed.
Never invest your money in anything that eats or needs painting.

Use it up...wear it out. Make it do...or do without.

Things are more like they are now than they ever were.

Nothing is lost until you begin to look for it.

Be kind.

Everything takes longer than it takes.

Anything that can go wrong will go wrong.

We are what we pretend to be.

We are all in the gutter but some of us are looking at the stars.

The 1210 Virus is due to strike tomorrow. Scan all drives today. (This message does not indicate the presence of a virus...it is
False teeth don't hurt.

Every moment has its special message.

Rest of mind is as important as rest of body.

The will to win and to achieve goes dry and arid without reinforcement.
A striking difference between a cat and a lie is a cat has but 9 lives.

You become successful the moment you start toward a worthwhile goal.
Better one cow in the stall than ten in the field.

A mind, stretched by a new idea, never regains its original dimension.
Look for cats and you find mice.

The future belongs to those who believe in the beauty of their dreams.
When you have figs in your havershack everybody seeks your friendship.
Cherish your visions and your dreams: they are the children of your soul.
Where the rope is worn, it will break.

Nothing happens unless first a dream.

An empty wallet is just a piece of leather.

To be a winner, all you need to is all you have.

A torn sack can't be filled.

If everyone moves forward together, the success takes care of itself.

A herring can serve ten persons, chicken barely two.

Persistence prevails when all else fails.

A dog without teeth will also attack a bone.

You can't steal second base while keeping your foot on first.

Even though an ox goes to town, it still comes back an ox.

To stay the course sometimes you have to make waves.

The wise conceal intelligence...the foolish display ignorance.

Accept the challenges so that you may feel the exhilaration of victory.
Three things grow overnight: interest, rent money, and children.

A champion is someone who gets up even when they can't.

A miser and a fatted calf are both useful only after death.

The difference between ordinary and extraordinary is the little extra.
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No matter how long you domesticate a wolf, he still longs for the forest.
Keep your face to the sunshine and you cannot see the shadows.

A nut tree won't grow apples.

No one can predict to what heights you can soar.

Teeth remain teeth even if all you eat with them is porridge.

Success is a journey, not a destination.

When the light is crooked, the shadow is crooked.

Energy and persistence will conquer all things.

A good wine is of no use in a rotten barrel.

If we don't take care of the customer, somebody else will.

Wealth is like hair in the nose; if much is pulled out, it is painful.

...if little, it is still painful.

You cannot discover new oceans without courage to lose sight of the shore.
Where there's honey, there are flies.

Teamwork is the fuel that allows common people to attain uncommon results.
If you heat the bath-house, the whole town warms up.

You are assured of missing 100% of the shots you don't take.

When a patient visits the doctor, the first one helped is the doctor.

The race is not always to the swift, but to those who keep on running.

If it doesn't work, try harder.

The Pretoria virus is due to strike tomorrow. Scan all drives today. (This message does not indicate the presence of a virus...i
Happy summer solstice!

At the baths, all are equal.

Some dream of worthy accomplishments, while others stay awake and do them.
It's John the Baptist's birthday.

Pride is an attitude which separates excellence from mediocrity.

Ten excuses are less persuasive than one.

The speed of the leader determines the rate of the pack.

If you need fire, look in the ashes.

Don't wait for your ship to come in: swim out to it.

You can go far with lies, but you can't return.

Today is Canada Day. Canadian business and government are closed.

The rainbows that gather today can be seen for a week.

It takes both rain and sunshine to make a rainbow.

Oh say can you see, by the dawn's early light, what so proudly we stand...
The race for quality has no finish line.

The woods would be very quiet if the only birds singing were those that sing best.
The best lie is the truth.

It's up to you: complain about the thorns...or rejoice in the roses.

When the stomach is empty so is the brain.

Physician, heal thyself.

You may drink from a skull but you may never forget it once had eyes.

The table alone won't satisfy hunger: only what's placed upon it.

Lending should be done with witnesses, giving without.

The loftier your goals, the higher your risk, the greater your glory.

If you have bread you can always find a knife.

Some succeed because of destiny: most succeed because of determination.
A whole fool is half a prophet.

Life does not require us to be biggest or best, it asks only that we try.
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Even when foolishness succeeds, it's still foolishness.

Beware the moon.

A kite rises against the wind rather than with it.

We cannot direct the wind, but we can adjust the sails.

If you act like a donkey, don't get insulted if people ride you.

Find the rule: the exception comes later.

The only people who fail are those who do not try.

If people listened to themselves more often, they would talk less.
Don't forget to sharpen the saw.

Persistence prevails when all else fails.

The ocean can't be emptied with a spoon.

Obstacles are those frightful things you see when you lose sight of goals.
To knock your head against the wall, first you must have a wall.
Every job is a self-portrait of the person who did it.

Once the table is prepared, guests will soon appear.

In the middle of difficulty lies opportunity.

Carry a ukele.

Some make things happen, some watch them happen, some wonder what happened
The people whose seats are furthest from the aisle always arrive last.
All the flowers of tomorrow are in the seeds of today.

Integrity is better than a precious stone.

To view the world at 50 the same as you did at 20, is to waste 30 years.
Nuts often come to toothless people.

The best way to prevent the future is to invent it.

Food is cooked in the pot and the the plate gets the credit.

A person going nowhere can be sure of reaching their destination.
Confidence is half the victory.

Perfection is our goal.

The sun shines brighter after a shower.

When we take care of our customers, we take care of ourselves.
With hope alone you can go crazy.

Always give people more than they expect to get.

Either the landowner will die or their dog will.

Customer complaints are the schoolbooks from which we learn.

A worm in the horseradish thinks there's no sweeter place to be.

It takes months to find a customer...seconds to lose one.

The bell rings because its empty.

None of us is as strong as all of us.

If you send a fool to close the shutters, he'll close them all over town.
Companies don't succeed...people do.

By the time you convince a horse to stop eating, it will up and die.
You become successful by helping others become successful.

If you need a shoe that fits, don't try it on someone else's foot.
Attitudes are contagious...make yours worth catching.

There is no better heart exercise than reaching out and lifting people up.
Amongst the shoemakers, the best tailor is a carpenter.

Don't show a fool a job half-done.

Not all horses are alike.

The sun will set without your assistance.
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The wise know what they do not know.

A meowing cat catches no mice.

If you don't have enough to do, sleeping is also work.

A dragon stranded in shallow water furnishes amusement for the shrimps.
It's best learn barbering on someone else's head.

Interdependence is a higher value than independence.

A good tool is half the artisan.

Make it idiot-proof and someone will design a better idiot.

Too many shoemakers go barefoot.

Sometimes the way we see the problem is the problem.

Sometimes the wagoneer rides facing the horses so long that he becomes a horse.
We are what we repeatedly do. Excellence then, is not an act, but a habit.
An example isn't proof.

The Frodo virus is due to strike tomorrow. Scan ALL files today. (This message does not indicate the presence of a virus...it is
Begin with the end in mind.

With luck, even your ox will calve.

What lies behind us and before us are tiny compared to what lies within us.
When luck calls, offer it a seat.

If your tent is too crowded, bring in the camels.

Don't allow a fool to make a speech: he might babble out the truth.

Put first things first.

If one person says you have donkey ears, ignore them. If two, buy a saddle.
The 1704-Format virus is due to strike tomorrow. Scan all drives today. (This message does not indicate the presence of a vir
Things that matter most must never be at mercy of those that matter least.
You can't make cheesecake out of snow.

Having committed the Golden Rule to memory; let us now commit it to life.
Even for bad luck you need luck.

Seek first to understand, then to be understood.

A bad penny never gets lost.

All locks open with a golden key.

The heart has its reasons which reason knows not of.

If you have no boots, consider going barefoot.

The Datacrime virus is due to strike tomorrow. Scan all drives today. (This message does not indicate the presence of a virus.
There are no little things.

When one must, one can.

When you need salt, sugar won't do.

When a coat is old, only the holes are new.

Turn the clocks back an hour by Sunday.

Happy Hallowe'en. AW000000000000000000000000!

Anyone can hate. It costs to love.

Time is an illusion perpetrated by the manufacturers of space.

A physicist is an atom's way of knowing about atoms.

The best way to predict your future is to create it..

We don't know who discovered water, but we are certain it wasn't a fish.
Try to be the best of what you are, even if what you are is no good.

Always do right. This will gratify some people, and astonish the rest.

If you can't learn to do it well, learn to enjoy doing it badly.

When you find yourself in a peach orchard, don't go looking for rutabagas.
Those who cannot remember the past are condemned to fulfil it.
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The first rule of intelligent tinkering is to save all the parts.

If your parents never had sex, chances are you won't either.

The meek shall inherit the earth, but not its mineral rights.

Lotteries are a tax on people who are poor at arithmetic.

It usually takes more than two weeks to prepare a good impromptu speech.
Martyrdom is the only way a person can become famous without ability.
Wisdom consists of knowing when to avoid perfection.

If computers get too powerful, we can organize them into a committee.
Logic is an organized way of going wrong with confidence.

A stick is a boomerang that doesn't work.

If it ain't broke,

don't fix it.

Nobody notices when things go right.

Real knowledge is to know the extent of one's ignorance.

Life is what happens to you while you're busy making other plans.

The difference between genius and stupidity is that genius has limits.
Only the mediocre are always at their best.

He who wonders discovers that this in itself is wonder.

People with narrow minds usually have broad tongues.

Change is inevitable, except from a vending machine.

Morfy's law: Enythink thit ken go rong willl.

When working toward the solution, it always helps if you know the answer.
Today is the anniversary of the Immaculate Conception.

To every rule there is an exception, and vice versa.

Warning: Dates in Calendar are closer than they appear.

To know your friends, lie in a gutter, act drunk, and shout proverbs.

If you see ants on your staircase, know that there is semolina upstairs.
A lock keeps out only the honest.

TimeWise Tip:

You can speed filling out government tax remittance forms by picking up the total tax billed in the period from tl

Not a peripheral was stirring, not even a mouse...

Happy Holidays everybody, and a prosperous New Year.

TimeWise would make a nice last minute gift idea for a loved one...okay, perhaps not...
| didn't get any Christmas presents again this year. It's not too late...

It's the first of the month. Flip those calendars.

TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:

Speed estimating by creating a Charge Group containing all the categories you would have on an estimating w
Use the Client Mailing Label feature to print labels for holiday mailings. First, print a Client Telephone/Fax Dire:
Use the Keyboard Macros command (on the File menu) to save time by automating common sequences of key
To speed up TimeWise on network workstations, follow the instructions under the Help item called Speeding U
A memorized jobs list of all jobs in progress, sorted by client, due within a month makes an excellent agenda ft
A memorized jobs list of all estimates, sorted by client, makes an excellent agenda for sales meetings. You cat
Use the Work In Progress report at production meeting to keep a handle on which jobs are at risk of coming in
Use the Archive command to commit very old job information (perhaps what is more than a year old) to archive

TimeWise Annual Tip: If you use sequential job numbering, consider starting the new year with job numbers that start with the
TimeWise for Windows tip: To skip the New Session window, add your Nickname to the command line parameter U= in the pr
TimeWise for Windows tip: To skip the password window, add your Nickname and Password to the command line in the prop

TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:

If you upgrade from TimeWise Light to TimeWise, you can post billing and client information to many third part
If you upgrade from TimeWise Light to TimeWise, you can archive and shred older information.

If you upgrade from TimeWise Light to TimeWise, you can view and print many powerful management reports.
If you upgrade from TimeWise Light to TimeWise, you can design your own reports with a built-in report writer.
If you upgrade from TimeWise Light to TimeWise, you can use Charge Groups to speed charge entry.
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TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
TimeWise Tip:
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If you upgrade from TimeWise Light to TimeWise, you can merge jobs.

If you upgrade from TimeWise Light to TimeWise, you can design your own library of custom job lists.

If you upgrade from TimeWise Light to TimeWise, you can build estimates and write proposals.

If you upgrade from TimeWise Light to TimeWise, you can view and print a greater variety of job lists.

If you upgrade from TimeWise Light to TimeWise, you can view and print sales commission reports.

If you upgrade from TimeWise Light to TimeWise, you can generate a variety of client experience and sales re
If you upgrade from TimeWise Light to TimeWise, you can print telephone and fax directories.

If you upgrade from TimeWise Light to TimeWise, you can use the Client Mailing Label feature to print labels f
TimeWise for Windows and TimeWise for Macintosh users can share data in real time over a network with an «
TimeWise for Macintosh and TimeWise for Windows users can share data in real time over a network with an «
TimeWise for Windows and TimeWise for DOS users can share data in real time over a network with an cross-
TimeWise for DOS and TimeWise for Windows users can share data in real time over a network with an cross-
If you wish to get rid of all the shipped noticeboard notices, choose Noticeboard from the Tools menu, click Ani
To issue a credit note, use the Bill command (from the Actions menu) and specify a negative amount as the in
To speed filling out sales tax remittance forms, use TimeWise's Billing Summary report to tell you exactly how

Beginner's Tutorial:
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